Team TimeSheet for Outlook
Help Manual for Administrators

Welcome
Track task, time, mileage and expense for project management, billing and payroll purpose with Microsoft Outlook.
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This is an elaborate help documentation that will guide you how to work with the management module of Team
TimeSheet for Outlook. For a quick overview, refer to our video demonstration available on the product website.
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11. Important links

1. Introduction
Team TimeSheet for Outlook is a reporting solution for a team of any size to work, plan and execute project related activities
and timesheets in Microsoft Outlook and publish to a central database. It leverages the familiar Outlook calendar and task
interface to track time and expenses towards projects, clients or any entity your business requires. And let you measure
attendance, payroll, cost estimation or billing for accounting purposes. Due to the seamless integration of timesheet
collection in Outlook and your network database, user adoption is maximized, yet training time and costs are minimized, and
most importantly, reporting process of work done and expense is streamlined for all employees, resulting in a highly scalable
solution for the organization.
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Purpose of this add-in
Microsoft Outlook, in its original state, lacks a direct and an efficient solution to track time, expense for payroll and billing
purposes. However, there are workers who indulge themselves in some form of timesheet tracking (and often crudely)
through capturing the time and other data from appointments and tasks in Outlook and feeding to an external data source
manually.
With Team TimeSheet, these processes are streamlined and automated so that administrator specified projects, activities and
other related metadata are available on every worker’s Outlook. With these project metadata, even if one is offline from the
workplace, individual team member can track, measure work done and prepare timesheets for projects from the comfort of
Outlook. Once timesheet in appointments or tasks are prepared in Outlook, member can publish to a network database. With
the inbuilt Summary Reports or OLAP Statistical tools (or with a 3rd party reporting solution), Managers can then use these
submitted timesheets for calculating expenses, payroll or billing on projects, clients and resources among others.
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Leverage Outlook for team reporting
Leveraging the familiar workflow of Outlook appointments and tasks, Team TimeSheet simplifies timesheet creation,
submission and tracking. Besides, it also offers managers and administrators greater control throughout the time reporting
process. With the assurance that team members are reporting through Outlook that promotes accurate, consistent time
reporting, managers can leverage precise, up-to-date budget and billing reports for project estimation and budgeting.
Designed to provide a fast return on investment, proven and scalable capabilities make Team Timesheet, a must for
organizations that require an enterprise time and billing management solution.

What are the advantages?
•
•
•
•
•
•
•

•
•
•
•

Seamless integration with Outlook
Prepare timesheets in Outlook calendar or task
Publish timesheets on a network database
Record time and expenses against configured projects and activities.
Support for revision of timesheet periodically over time.
Support color coding of tagged Outlook items
Access Control module for controlling which project fields are deployed, how individual member interact and report in
Outlook, which members have access to administrative tools and if they are allowed to add their own projects and
activities.
Enforce project timeline (i.e., start, end date and due date) in tagged appointment and task items in Outlook.
Keep vital project information fully up to date among the members.
Streamline the timesheet collection and reporting techniques via Outlook for all members with centralized administration
control panel.
Set reporting rules and guidelines for members, such as minimum work hours, mandatory fields and valid project codes
Offline support - members can continue on timesheet entry in Outlook, and only report to database when connected to
the network.
Deploy Custom Fields for measuring additional project deliverables
Integrated OLAP reporting tool with more than 30 pre-defined reports available
As the database is open, you can use 3rd party reporting solution to generate statistics, reports etc.
Supports Office 2010, Ribbon, Backstage View and context menu
Included are project specific Outlook views that bring sense to your timesheets
Because it is based on Outlook, Team TimeSheet can be deployed rapidly throughout your organization with high
scalability.
And by presenting users with the Outlook user interface they're already familiar with, training time and costs are greatly
minimized.
Real-time graphical reports provide immediate insight into productivity
Automated e-mail notifications to prompt timesheet submission and other events
Replace paper based timesheet entry and disparate IT systems to avoid data falling into the cracks and information loss.
Groupware solution - simple Managerial and Client install.

•

Reduces time misappropriation

•
•
•
•
•
•
•
•
•
•
•
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•

2. Requirements
Team TimeSheet is available right inside your Outlook unlike any other standalone application and web based project and time
reporting software. It can be easily deployed through an installer (manually or via a group policy object with MSI) across the entire
organization. Please make sure that your system meets the following requirements before installing Team TimeSheet for Outlook:
Windows Version

Windows Vista, 7, 8, 8.1, 10. Both 32-bit and 64-bit OS are supported.

Outlook Version

Outlook 2019, 2016, 2013, 2010, Outlook 2007. Team TimeSheet operates directly inside
the Microsoft Outlook application (using Microsoft's "COM add-in" technology). Outlook
Express is not supported.

Database

Microsoft Access, all versions and editions (including Express edition) of SQL Server are
supported including cloud services such as Amazon RDS and Microsoft Azure SQL.

Others

Microsoft .NET Framework 4.5

Page

6

.

3. Installation
Team TimeSheet consists of two separate installs – Admin and Client. The Admin install is for project managers and administrators
who would setup and configure projects and activities, and maintain drop down lists, templates, reporting settings etc. in a Project
database accessible to all members of the team. Whereas, the Client install is meant for normal users who would be preparing
timesheets in Outlook before reporting and submitting to the project database.
(Note that, if the administrator needs to publish timesheets from Outlook to Database, the client tool also needs to be installed,
apart from the managerial portion).
There are two different setup types:
For 'Per User Installation' (ideal for standalone single user/workstation)
TeamTimeSheetSetups_x86.zip (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019)
TeamTimeSheetSetups_x64.zip (for 64-bit Outlook 2010, 2013, 2016, 2019)
For 'Per Machine Installation' (ideal for installing on Citrix and Terminal Servers)
TeamTimeSheetSetups_x86_Citrix.zip (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019)
TeamTimeSheetSetups_x86_Citrix.zip (for 64-bit Outlook 2010, 2013, 2016, 2019)
The downloaded zip file contains 3 files: TeamTimeSheetManagerSetup_xXX.exe, TeamTimeSheetClientSetup_xXX.exe and
VersionInfo.txt where ‘xXX’ can be either x86 (32-bit Outlook) or x64 (64-bit Outlook)
Extract these file contents to a file folder. It is recommended that you place the setup files on a shared network folder, such that all
users can have access to it, and ease the installation and upgrade process.
Before continuing with the installation, don't forget to go through the System Requirements page. For version numbers and changes
history, refer to the Version History page.
Per User Installation and Per Machine Installation
Per User Installation: both the Manager and Client installs are performed 100% on the local system and nothing is installed on your
Exchange or Windows Server. Further, this install is intended to serve only the current logged on user of the system/workstation and
will be installed under the user's application data folder (instead of Programs Files folder) and no elevated permission is required
(This is known as per user installation). So, there won't be a prompt from UAC to allow this install unless you change the install
directory to say, Programs Files which will warrant an elevated permission/UAC prompt. If the same system is used by multiple
users, each user needs to install Team TimeSheet add-in on their profile with the default installation folder location.
Per Machine Installation: If you have the need to have a single install that serves all users of the system (i.e., per machine
installation, which technically means the files will be installed under Program files folder and the add-in will be registered under
HKEY_LOCAL_MACHINE registry hive rather than HKEY_CURRENT_USER), download the Citrix/Terminal Server version of the setups
to perform a per machine installation.
The Admin setup is of two different types - one each for 32-bit Outlook and 64-bit Outlook
For Per User Installation:
TeamTimeSheetManagerSetup_x86.exe (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019)
TeamTimeSheetManagerSetup_x64.exe (for 64-bit Outlook 2010, 2013, 2016, 2019)
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For Per Machine Installation:
TeamTimeSheetManagerSetup_x86_Citrix.exe (for 32-bit Outlook 2007, 2010, 2013, 2016, 2019)
TeamTimeSheetManagerSetup_x64_Citrix.exe (for 64-bit Outlook 2010, 2013, 2016, 2019)

Managerial Installation
This has to be performed by the administrator before the Client tool is installed on every user's system. Step by step
procedure is given below:
Step 1. Run the TeamTimeSheetManagerSetup_xXX.exe to start the installation. Click 'Next' to Continue. If Outlook 2007 or
later is not installed, the setup wizard will not be able to proceed. Please also ensure Outlook is shutdown (if already running
or active in the task manager) as the setup has to install an Outlook add-in.
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Step 2. Select the appropriate destination folder where the application files will be installed. If you change the default folder
path, please make sure you have appropriate permission. (Note: by default, it will be installed under your application data
folder)

Step 3. Click 'Next' to continue with the files extraction. It just takes a few minutes to complete the whole copying process
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Step 4. Click 'Finish’. This ends the files installation process in your system. Now start Microsoft Outlook

4. Configuring TimeSheet Database
The next step is to choose a database option and configure it to store the project metadata such as project/activity lists, notification
options, email templates, members list, reporting settings etc. as well as other global settings that streamline the behavior on how
all members work, track and publish their timesheets in Outlook.
If you have just installed the Team TimeSheet Manager add-in, you will see ‘Project Data Source’ dialog when you start Outlook.
Alternatively, you can invoke this dialog box from Outlook > the backstage File > Team TimeSheet Manager > Project Data Source
button.

You can choose a project database between a Microsoft Access (MDB file) to a Microsoft SQL Server (or cloud SQL service too), or
Azure SQL Database (cloud db).
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i) Using Microsoft Access - If you choose ‘Microsoft Access’, the database file (e.g., TeamTimeSheet.MDB) will need to be placed on
a shared network folder such that all members (that have the Client add-in in their Outlook) have access to the network folder.
When you specify the location where the MDB file is to be created, make sure you choose a UNC path (e.g.
\\AMTServer\TimeSheets) instead of a mapped one because, a mapped drive might only be accessible to you.

One important consideration with having a network Access database is the write permission on the folder and the MDB file itself.
Make sure, the shared folder or the MDB file is not configured ‘read-only’ for all members on the network, otherwise, they won’t be
able to publish their timesheets to the database from their respective Outlook.

ii) Using Microsoft SQL Server - It is recommended to use a dedicated SQL Server database option, if you have a high number
of users (> 25) publishing their timesheets from their Outlook to the database, as it gives a better performance and is easily
scalable.

For SQL server, the server name is mandatory. The Database name is optional. If it is left empty, a new database with the
name ‘TeamTimeSheetDB’ would be created. If your SQL server is configured to use windows authentication (NTLM), then
you can check the ‘Use Integrity Security’ option to let Windows manager the credentials to access the resources on the SQL
server.
Permission for users on the SQL database - Each member should have both db_datareader and db_datawriter permission on
the Team TimeSheet SQL database.
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Using Cloud based SQL Server database
You can also use cloud based SQL server service instead of on-premise such as Amazon RDS cloud service (They offer both free
and paid accounts. For more, refer to https://aws.amazon.com/rds/). For instance, below is our test MS SQL account with
Amazon RDS. Once you have signed up and created a MS SQL database, input the endpoint URL as server in our app. Make
sure, you suffix the port number after the endpoint as “,1433” so that the full URL in the server name would be
‘XXXXXXXXXXXXXXXXXXXXXXXXX.rds.amazon.com,1433’.

And here is screenshot of the RDS server to use from the RDS member panel.

iii) Using Microsoft Azure SQL – Azure SQL Database is a cloud-based relational database service from Microsoft, which is
based on SQL Server database. This option is ideal for team that have users scattered or working remotely in different
locations but have access to the web.

NOTE: If no database name is mentioned, the manager add-in will create a new database in your Azure SQL server, by the
name of 'TeamTimeSheetDB’.
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Once you click ‘Save’, the manager tool will automatically create the chosen database (if it does not exist already). And then
any project metadata and other settings/drop down lists you defined from Team TimeSheet Manager add-in in Outlook would
be saved in this repository.

5. Managerial Settings
The Team TimeSheet Managerial tool provides a central panel that allows administrator to customize the contents of all project
drop-down boxes, templates for outgoing emails, notification options, custom fields etc. Project data and managerial settings are
stored on a network database, accessible to all members of the organization.
The Team TimeSheet menu serves as the gateway for launching most of the functionalities and tools available in Team
TimeSheet with Outlook. In Outlook 2016, you would find the Team TimeSheet Manager menu in the backstage file button, as
shown below.
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Team TimeSheet Manager (backstage view of Outlook 2016)

5.1 Team Members
Team TimeSheet Manager > Team Members
Team TimeSheet Manager needs to maintain the detail of each member that would be reporting to the central database. The
member name and email address are mandatory fields and should be unique for each member in the list.

Import members from Global Address List/Active Directory - Most likely, you might already have contact details of the
members in the exchange global address list. Use the 'Import...' button to display the address book and select those contacts
that you want to import. The member’s name, email, department fields would be then automatically filled in the grid.
Admin Access – You can grant administrative rights to certain members so that they can view statistics for all members, as
well, to allow them to add their own projects/activities and other project data from within their Outlook. For more on admin
access, refer to ‘Access Control’ settings.
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Notify a member to report their timesheet – As a project manager or supervisor, from time to time, you might need to
inform a particular member to report their project deliverables such as timesheets to the central database. Just click the
corresponding ‘Notify’ button to send out the alert email instantly. You can customize the email template for this alert from
the ‘Templates Manager’.

5.2 Projects List
Team TimeSheet Manager > Projects list
The Projects list panel allows the administrator to add projects and their related data such as manager, hourly rate, project
start and end date, project code and Outlook color code. There is no limit as to the number of projects that can be set up in
the system.

The project manager is chosen from drop down list of the team members that you get when you click the down button.
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To specify the Project start or finish date, just double-click the particular cell and it would popup the date picker.

The description field allows for a short description of the project. This short description is displayed to each team member in
the ‘My Projects & Activities’ settings of the Team TimeSheet Client tool. So it is a good practice to put up a meaningful
description of each project.
If you have any internal naming convention for project, you can enter it in the ‘Project Code’ field.

To specify a color code of the particular project, click the corresponding button on the ‘Color code’ column of the row to
display the color picker. Note that, only 26 colors are supported for color coding Outlook items (such as appointments and
tasks).
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Lastly, administrator can click the corresponding ‘Notify all Members’ button of a particular project to send out an email notification
alert to all or selected members to report their tasks and timesheets (relating to the particular project) from Outlook to the central
database. The administrator can customize this email template via the ‘Team TimeSheet Manager > Templates Manager’ panel.

5.3 Activities List
Team TimeSheet Manager > Activities list
The Activities list in the project management system is the central place where all project activities are added. There is no
limit to the number of activities per project.

You can define the due date for each activity by double-clicking the corresponding cell of the ‘Due Date’ column.
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The activity coordinator is chosen from drop down list of the team members, that you get when click the down button.
Lastly, administrator can click the corresponding ‘Notify all Members’ button of a particular activity to send out an email
notification alert to all or selected members to report their timesheets and related project data from Outlook to the central
database. The administrator can customize this email template via the ‘Team TimeSheet Manager > Templates Manager’
panel.

5.4 Custom Fields
Team TimeSheet Manager > Custom Fields
You can use Custom fields and Custom list for extracting additional project or activity related data when reporting from within
the Outlook task or appointment item.

Custom fields can be of 6 different data types as displayed in the image above:
Currency, Date/Time, Numeric, Text, Yes/No, Note.
You can add any number of Custom fields as required and
they will all appear in the timesheet form in Outlook.
You also have the option to even mark a custom field
Mandatory when Reporting, so that without filling the
mandatory fields, the Outlook appointment items or task
items cannot be reported/published.
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Once a field is marked mandatory it would be displayed in
red color so that user can identify the mandatory fields.

Custom List
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The titles of these custom list can be edited to get the proper meaningful label that signifies the information the field store.
For example, the first drop down field can be titled as ‘Client’ and the administrator can fill up the names of all their clients
for which projects are contracted for.

5.5 Access Control
Team TimeSheet Manager > Access Control
In this panel, the administrator can control what particular subset of features and options are available to the team members.

List of team members with no admin access (one with the red background). You can use the buttons >> or << to
swap the access level.
List of team members with admin access (one with the green background). You can use the buttons >> or << to swap the
access level
Add their own Projects – Enabling this option would allow team members with admin access to add new projects from
within the Team TimeSheet Client tool (Team TimeSheet Client > My Projects & Activities List).
Add their own activities – Enabling this option would allow team members with admin access to add new activities
for a project from within the Team TimeSheet Client tool (Team TimeSheet Client > My Projects & Activities List).
View Search/Summary Reports on all published timesheets (for all members) – If this is checked, only members
with admin access can view summary reports of published timesheets for the entire team. Leaving it unchecked
would load the summary reports of the current member only. (Team TimeSheet Client > My TimeSheet Summary
Reports)
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View OLAP Statistics on all published timesheets (for all members) – If this is enabled; only members with admin
access can view OLAP Statistics on published timesheets for the entire team. Leaving it unchecked would load the
OLAP Statistics reports for the current member only. (Team TimeSheet Client > My TimeSheet OLAP Statistics)

5.6 Form Options
Team TimeSheet Manager > Form Options.
The administrator has the provision to customize the titles of the project, activity, give permission to allow members to
choose their own projects and activities. The changes in the titles here are reflected to the Team TimeSheet Client tool i.e., in
the timesheet form, toolbars and ribbons in Outlook.

Title to use – Input the meaningful label that best describes the data the Project and Activity fields would store. These labels
would be deployed to the timesheet form, toolbars etc. So, best practice would be to use a single word or two, which is easily
recognizable to the kind of data it would store. By default, project field uses ‘Project’ and for ‘Activity’ for the Activity field.
Mandatory for reporting – When team members submit their time sheets and other data, you can set certain fields as
required or mandatory before accepting the reported data (into the database). When a team member tries to submit
timesheet or other reportable data without filling in the mandatory fields, the Team TimeSheet Client process would
automatically display a warning message.
Allow members to choose their own Projects and activities in their Outlook
When you enable this option, team members who are working on Team TimeSheet for Outlook would be able to choose their
own projects and activities as in ‘Team TimeSheet for Client > Personal Setting >My Projects/Activities’.
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Substitute the logo with your own
You can specify an image of your choice and upload the image file by browsing the the image located. This uploaded image
would be displayed in Team TimeSheet Client item forms.

5.7 Templates Manager
Team TimeSheet Manager > Templates Manager
Team TimeSheet for Outlook uses various emails for sending out notifications and reminders to managers and team members
- both manual and automatic. Email notifications take HTML.

There are a whole lot of notification options for different events such as email to manager when a new timesheet is submitted
or withdrawn, or when new projects or activities are added by the administrator, or when a project manager is assigned etc.
Automated emails are sent out directly when a relevant event occurs and the whole exercise is transparent to the users.
A list of all templates used for printing and email notifications:
Template
Email Manager when member publishes
timesheet
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Email Coordinator when member publishes
timesheet

Purpose
HTML template of the notification email that is sent
automatically to the project manager when a user
submits timesheet and other deliverables from
Outlook to Database.
HTML template of the notification email that is sent
automatically to the activity coordinator when a user
submits timesheet and other deliverables from
Outlook to Database.

Email Members when new projects are added

HTML template of the notification email that is sent
to all members when the administrator adds new
projects.

Email Members when new activities are added

HTML template of the notification email that is sent
to all members when the administrator adds new
activities of a project.

Email Manager when assigned a project

HTML template of the notification email that is sent to
the particular manager when a project is assigned.

Email Coordinator when assigned an activity

HTML template of the notification email that is sent
to the particular coordinator when an activity of a
project is assigned.

Email Manager on withdrawal of published
timesheet

HTML template of the notification email that is sent
to the project manager when a member withdraws a
reported timesheet from Database.

Email Coordinator on withdrawal of published
timesheet

HTML template of the notification email that is sent
to the activity coordinator when a member
withdraws a reported timesheet from the Database.

Email Members to submit timesheets on a project HTML template for email that is sent out to selected

or all members by the administrator (via the Team
TimeSheet Manager > Projects list) manually to
notify to submit deliverables and timesheets on a
particular project.
Email Members to submit timesheets on and
activity

HTML template for email that is sent out to selected
or all members by the administrator (via the Team
TimeSheet Manager > Activities list) manually to
notify to submit deliverables and timesheets on a
particular activity of a project.

Email Member to submit timesheets

HTML template for email that is sent to a particular
member by the administrator (via the Team
TimeSheet Manager > Team Members) manually to
notify to report their timesheets and project
deliverables.

Email Manager when member updates (revises)
timesheet

HTML template of the notification email that is send
automatically to the project manager when a user
updates or revises existing timesheet and other
deliverables from Outlook to Database.

Email Coordinator when member updates (revises) HTML template of the notification email that is send
timesheet
automatically to the activity coordinator when a user
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updates or revises existing timesheet and other
deliverables from Outlook to Database.

A list of all placeholder variables available for inserting into a particular template. In runtime (that is, when the
actual email is generated from the template), the enclosed variables will be substituted by their corresponding
values. The followings list all the supported variables:
Variable

Purpose

TTO_REPORTED_ID
TTO_PROJECT
TTO_ ACTIVITY
TTO_CREATION_TIME

Unique ID that is automatically generated when a report is
submitted to the database.
Project name of the reported item
Activity name for a project of the reported timesheet
Creation time of Outlook item that is being reported

TTO_SUBJECT
TTO_COMPANIES

Subject of the Outlook item that is bring reported
Companies field of the Outlook item that is being reported

TTO_CATEGORIES
TTO_BILLINGINFORMATION
TTO_DURATION
TTO_BODY

Categories field of the Outlook item that is being reported
Billing Information field of the Outlook item that is being reported
Duration of the Outlook item that is being reported
Body description of the reported Outlook item

TTO_START

Start date of the Outlook item

TTO_DUE_OR_END

Due date (in case of task item) or End date (in case of
appointment item)
Date/time the Outlook item was reported to the database

TTO_REPORTED_DATE
TTO_MEMBER
TTO_TOTALCOST
TTO_APPROVED

Name of a particular member
Total cost that is computed after the item is reported successfully
Audit status of the reported item. If TRUE, it is approved, else it is
rejected (declined).

TTO_APPROVEDBY
TTO_MANAGER

The user/administrator who audited the reported item in the
database.
The manager of the particular project

TTO_COORDINATOR
TTO_ACTIVITY_DUE_DATE
TTO_NOW

The Coordinator of the particular activity of a project
The Due Date of the particular activity of the project
Current date/time stamp

TTO_REPORTED_BY
TTO_HOURS

Name of the member who submitted the item to the database
Billable Hours

Note: Some of the variables might not be available for embedding on certain templates when not applicable.

Subject of the active template. This can be customized and can take placeholder variables.
A WYSIWYG HTML editor with which you can customize the contents, apply HTML formatting as well as insert the
placeholder variables. The look and feel as well as the buttons and functionalities are similar to Microsoft FrontPage
authoring tool.
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The actual template in its raw state.

5.8 Notification Options
Team TimeSheet Manager > Notification Options
Automatic Email Notifications - Automatic email notification and alerts are essential for keeping managers and team
members informed with the progress and status of the project.
Team TimeSheet offers a whole lot of notification options for different events of project management and tracking. These
email templates can be altered using the ‘Templates Manager’. Automatic emails are sent out directly when a relevant event
occurs and the whole exercise is transparent to the users.
Check the box of the corresponding notification that you want to enable and then click 'Save' button.
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Notify Manager when a team member submits timesheet to the database– This notification email is sent out to
the concerned manager in-charge of the particular project on which the member has reported.

Notify Coordinator when a team member submits timesheet to the database – This notification email is sent out to
the concerned coordinator in-charge of the particular activity of a project on which the member has reported.
Notify Manager when a team member updates existing timesheet to database – This notification email is sent out
to the concerned manager in-charge of the particular project when a member updates and revises an existing
timesheet in database.

Notify Coordinator when a team member updates existing timesheet to database – This notification email is sent out to
the concerned coordinator in-charge of the particular activity of a project when a member updates or revises an existing
timesheet in the database.
Notify Manager when a reported timesheet is withdrawn by the member – If withdrawal of reported timesheet is
allowed, this notification email would be sent out to the concerned project manager when member withdraws the
reported timesheet from the database through Outlook.
Notify Coordinator when a reported timesheet is withdrawn by the member - If withdrawal of reported timesheet is
allowed, this notification email would be sent out to the concerned activity coordinator when member withdraws the
reported timesheet from the database through Outlook
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Notify manager when new project is assigned - This notification email is sent out to the newly assigned manager
informing about the assignment of the particular project.

Notify coordinator when new activity is assigned - This notification email is sent out to the newly assigned
coordinator informing about the assignment of the particular activity.
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Notify team members when new projects are added – This notification email is sent out to team members
informing about the availability of new projects when manager or administrator adds new projects from Team
TimeSheet Managerial tool.

Notify team members when new activities are added – This notification email is sent out to team members
informing about the availability of new activities of a project when administrator adds new activities from Team
TimeSheet Managerial tool.

Notify member when reported timesheet is declined – If audit function is enabled and if project managers and
supervisors decline the reported timesheet, this notification email is sent out to the particular member apprising
about the decline.
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Notify member when reported timesheet is approved - If audit function is enabled and if project managers and
supervisors accept the reported timesheet, this notification email is sent out to the particular member apprising
about the acceptance.

5.9 Reporting Options
Team TimeSheet Manager > Reporting Options
With the reporting options, administrators can control and streamline how all members report project deliverables from the
Outlook client to the project data repository.

For appointments, only allow reporting from the default calendar folder – If this option is enabled, Team
TimeSheet client in Outlook will only function from the default calendar folder of the primary mailbox. This can be
useful to limit the reporting of project deliverable and timesheets from a single calendar in Outlook.
For tasks, only allow reporting from the default task folder – If this option is enabled, Team TimeSheet client in
Outlook will only function from the default task folder of the primary mailbox. This can be useful to limit the
reporting of project deliverable and work done from a single task in Outlook.
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Allows members to update published timesheet data– If this option is enabled, it would allow members to
resubmit reported timesheets or deliverables and overwrite existing data on the database. A new UI ribbon button
with the caption ‘Update Report #12’ for example, would appear in the Team TimeSheet Outlook toolbar or ribbon. This
feature helps members to report their incomplete timesheet or task deliverables, while at the same time, giving them
flexibility to re-submit or update the same reported timesheet in due course of time.

Allow members to withdraw published timesheet - If this option is enabled, it would allow members to withdraw
(remove) reported timesheets or deliverables from the database. A new UI ribbon button with the caption
‘Withdraw Report’ would be available in the Team TimeSheet toolbar or ribbon in Outlook. This withdrawal feature
comes handy when members want to start-over their timesheet or work done which were already submitted.

Prevent members from posting items with expired projects - when enabled, Team TimeSheet would prevent
members from submitting timesheets and other deliverables from Outlook, if the tagged project has expired
already.
Prevent members from posting items with expired activities - when enabled, Team TimeSheet would prevent members
from submitting timesheets and other deliverables from Outlook, if the tagged activity of the project has expired already.
When updating existing timesheet from Outlook by another user, retain the original user of the ReportedBy field
If this feature is enabled then when any existing timesheet is updated from Outlook by another user who have not
Reported the timesheet, it will not display the user’s name instead it would retain the original User who have Reported
the timesheet. Else it would use the name of the user who is updating the existing timesheet.
Don’t allow posting of items with work less than X mins – If you have a minimum work time required for accepting
timesheet and other project deliverables, you can set it in minutes. When members report to the database, if the
work duration (i.e., duration of the appointment item or total work hours for task item) is less than the minimum
required time, the reporting would stop and a friendly message is displayed.
When reporting from Shared Calendar, ReportedBy field of the timesheet will take the name of
If ‘Current User who is performing the reporting’ is chosen, then it will show the current user who reports the item in
the Shared Calendar.
If ‘User Name of Shared Calendar’ is chosen, then it will take the name of the Shared Calendar where timesheet
items are reported.
When a recurring appointment is published in master/entire series mode, use
If recurring appointment is published, you can choose 3 different modes to be used:
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•
•
•

the same Project/activity and custom fields of the master for all the occurrences
the project/activity and custom fields of the master only if the corresponding field data is empty in the occurrence
the project/activity and custom fields of individual occurrence

Reported repository for task items – enable this option to place a copy of the reported task item to a public task
folder.
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Reported repository for appointment items – enable this option to place a copy of the reported appointment item
to a public calendar folder.

5.10 Audit Options
Team TimeSheet Manager > Audit Options
The audit options provide administrator if to enable approval management module and what all audit features will be
available. If auditing is not enabled, timesheets and other project deliverables are automatically approved upon submission.
By default, auditing is disabled.

Enable editing values of Project/Activity – You can set managers and supervisors to manually change and edit the
project data in the submitted timesheet before or after approving it.
Enable editing of Cost – likewise, checking this option would enable managers to adjust and change the cost on the
reported timesheet.
Enable editing values of Billable Hours – You can set managers and supervisors to manually change and edit the Billable
Hours in the submitted timesheet before or after approving it.
Enable editing values of Custom Fields – You can set managers and supervisors to manually change and edit the custom
fields data (if deployed) in the submitted timesheet before or after approving it.
Notify member when reported timesheet is approved – This would automatically generate an email notification
informing the particular member about the approval of the submitted timesheet or other deliverables.
Display the email before sending to the member – By default, email notification for approval would be sent
automatically. However, this can be changed by enabling this option, whereby the notification email on approval
would be displayed to the manager for any additional note, that manager might want to put in.
Notify member when reported timesheet is declined - This would automatically generate an email notification informing
the particular member about the decline of the submitted timesheet or other deliverables.
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Display the email before sending to the member - By default, email notification for decline would be sent
automatically. However, this can be changed by enabling this option, whereby the notification email on decline
would be displayed to the manager for any additional note, that manager might want to put in.
Permanently remove declined timesheet from the database – Enabling this option would permanently remove the
declined timesheet or deliverables from the database.

5.11 Advanced Options
Team TimeSheet Manager > Advanced Options
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In Project/Activity List, prompt me to select recipients before sending email reminder to report – Administrator
can send email alert manually to members to notify to submit their timesheets on a particular project or activity. By
default, it is sent out to all members, but enabling this check option would allow the administrator send the alert
email to the chosen members only.

In Project/Activity List, allow editing email reminder before sending to the recipients – Enabling this option
would allow the administrator edit the email alert before sending out to the members.

Show Duration/Billable Hours in Reports as – Duration and Billable Hours of timesheet published from Outlook to database
is always in Minutes format. And by default, when you run any reports on published timesheets, the default format will be
too, in minutes. However, if you want in hours, you can change here.

Update Start date of the item with the Project Start Date – If this is enabled, when member tags an appointment or
task item in Outlook, the start date of the Outlook item would be automatically updated to that of the Project Start
Date (provided the start date is defined in for that particular project in the list). If it is null, it is ignored.
Start date of the project ‘BBC Tech’ in the Projects List
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When the project ‘BBC Tech’ is selected and tagged to the task
item, the start date of that project is automatically assigned to
the start date of the task item in Outlook. E.g. 15th August 2010.

For Outlook appointment item, update End Date of the item with either the Project Finish Date or the Activity Due
Date

If Project Finish Date is enabled, when member
tags an appointment item with a project from the
drop down in Outlook, the end date of the
appointment item would be automatically
updated to that of the Project Finish Date
(provided the start date is defined in for that
particular project in the list). E.g. 19th August
2010. If it is empty/null, it is ignored.
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If Activity Due Date were chosen, when member
tags an appointment item with an activity value
from the drop down in Outlook, the end date of the
appointment item would be automatically updated
to that of the activity Due Date (provided the due
date is defined for that particular activity in the list).
E.g. 18th August 2010. If it is empty or null, it is
ignored.

For Outlook task item, update Due Date of the item with either Project Finish Date or Activity Due Date

If Project Finish Date is enabled, when member tags a task item
with a project from the drop down in Outlook, the due date of the
task item would be automatically updated to that of the Project
Finish Date (provided the finish date is defined in for that
particular project in the list). E.g. 19th August 2010. If it is
empty/null, it is ignored.
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If Activity Due Date were chosen, when member tags a task item
with an activity value from the drop down in Outlook, the due date
of the task item would be automatically updated to that of the
Activity Due Date (provided the due date is defined for that
particular Activity in the list). E.g. 18th August 2010. If it is empty or
null, it is ignored.

Total Cost Calculation

To calculate ‘Total Cost’ for reported timesheet, you can use the rate from one of the three –Project, Activity or Member.
The total cost is calculated automatically when member reports timesheets to database. By default, the rate for project is
used.
Rate in Projects List

Rate in Activities List

Rate in Members List

For calculating ‘Total Cost’ for Outlook task
items, you can use one of these two works done
field of the item – ‘Actual Work’ or the ‘Total
Work’.
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For calculating ‘Total Cost’, you can set the rate to be either hourly or your specified hours. By default, rate is
calculated on hourly basis.
For Calculating ‘Total Cost’ of a published timesheet, you can either choose Billable Hours or Duration of the appointment or
task item, that is being published. Default is Billable Hours field. Additionally, if Duration is chosen, you can hide the ‘Billable
hours’ field in the timesheet form.

5.12 Upgrade Options
Team TimeSheet Manager > Upgrade Options
With this feature, when a new updated version of Team TimeSheet is available, you can perform upgrade of the Team
TimeSheet Client tool on each member’s system automatically. If enabled, it checks for new version availability at Outlook
startup.

Auto-check of new version from www.assistmyteam.com and offer to install if a new version is available - Check this
option to enable automatic check of new version of the Team TimeSheet Client add-in from the product website at
www.assistmyteam.com during Outlook startup. If a new version is available, you will be offered if you want to open the
download page.

Controlled Upgrade – from an admin specified network folder - Check this option to enable automatic upgrade of
Team TimeSheet Client add-in from a network path, which is specified by the administrator. In the text box, specify
the network shared folder where the Client setup files (TeamTimesheetClientSetup_xXX.exe and VersionInfo.txt) are
placed. When new versions are available, all you need to do is download the latest version from the Team TimeSheet
download page, and then place the TeamTimesheetClientSetup.exe and VersionInfo.txt into this network folder.
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Display a message to the member on new version availability - This would display a message about new version
availability if one is found.

6. Search TimeSheet Database
Team TimeSheet Manager > Search TimeSheet Data
With the Search utility, administrators and managers can run queries on the published timesheets. A variety of search
parameters are predefined to help you find your published timesheets easily and quickly. You can also limit the search to your
published timesheets only by choosing 'My TimeSheets' scope.

Time Period: Choose a time period from the followings under which the search will be confined:
Any
Today
Yesterday
Tomorrow
This week
Last Week
Next Week
This Month
Last Month
Next Month
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This Year
Last Year
Date Range...

On
Report Type: Choose a report type from the predefined ones below:
Any
TimeSheets Starting
TimeSheets Ending
TimeSheets Reported
TimeSheets Ongoing
TimeSheets Approved
TimeSheets Declined
TimeSheets Pending Approval
TimeSheets Completed
TimeSheets with Empty Project
TimeSheets with Empty Activity

Search By: Further refine the search by filtering through keywords or using one of the following timesheet fields:
Project/Activity, Reported By, Duration, Billable Hours, Importance, Custom Lists.
Group By: You can choose to group the timesheets either with:
Project, Activity, Reported By, Importance, Categories.
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Fields – you are free to choose which particular timesheet fields/columns that will show up in the search result and
report. Just click the 'Fields' button, and choose the wanted columns to include.

The tool will remember your choice in
subsequent runs.
You can re-arrange the columns by
drag-and-drop to get the kind of view
you want. And the display order of the
columns will be retained in
subsequent sessions.
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Detail Info button: Click this to view finer detail information of the selected timesheet (as available in the project database) in
a new window.

Print: Click this to print the selected timesheets using the 'Print' template (as defined under Team TimeSheet Manager >
Templates Manager). If you select a single timesheet to print, it will show you the print dialog option, where you can
customize the layout, paper size etc. However, if you choose multiple timesheets, it will print directly using the default
settings without displaying any ‘Print’ options.
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Export to PDF: Click this to export the selected timesheets to PDF document files. You can also export to Word Documents,
HTML, plain text etc.

7. TimeSheet Summary Reports
Team TimeSheet Manager > TimeSheet Summary Reports
Reports summary reports play a vital role in keeping administrators informed about submitted deliverables, timesheets and
aggregate hours and expenses for the selected period. Managers would find it handy to keep track of current budget deficit
and work done, and plan and forecast requirements for resources and man power for remaining part of the projects etc.
It can be used to generate summarized and aggregate reports on submitted timesheets based on different time intervals such
as today, this week, this month, last month etc. Any predefined Outlook, user-defined and project specific fields can be chosen
for inclusion into the reports. Aggregated and summarized reports can then be exported to Excel, Text, XML or HTML web
page or printed for sharing and easy distribution.
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There are four report view modes - List, HTML, HTML Editable and Grid. Noticed that this report tool also uses the same sets
of search filters discussed in the last section.

Each timesheet in the search result is color coded to reflect the current state of the timesheet such as if it approved, decline
or approval pending. Now, you can easily recognize which timesheets require the attention or review, and plan actions
accordingly.

Time Period: Choose a time period from the followings under which the search will be confined:
Any, Today, Yesterday, Tomorrow, This week, Last Week, Next Week, This Month, Last Month, Next Month, This
Year, Last Year, Date Range, On
The option 'Date Range…' allows for user selection of start and end date.

Report Type: Choose a report type from the predefined ones below:
Any, TimeSheets Starting, TimeSheets Ending, TimeSheets Reported, TimeSheets Ongoing, TimeSheets Approved,
TimeSheets Declined, TimeSheets Pending Approval, TimeSheets Completed, TimeSheets with Empty Project,
TimeSheets with Empty Activity
Search By: Further refine the search by filtering through keywords or using one of the following timesheet fields:
Project/Activity, Reported By, Duration, Billable Hours, Importance, Custom Lists.
Group By: You can choose to group the timesheets either with:
Project, Activity, Reported By, Importance, Categories.
Fields: Click the ‘Field’ option to choose which particular timesheet fields/columns will show up in the search
result and report.
The tool will remember your
choice in subsequent runs.
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You can re-arrange the
columns by drag-and-drop
to get the kind of view you
want. And the display order
of the columns will be
retained in subsequent
sessions.

Print the current report - When you click ‘Print’, you would be presented with the print dialog (similar to one used
by Internet Explorer browser). Within that dialog, you would be able to customize the print settings. Note that, as
there are multiple report modes (namely, list, HTML, Grid), the printed report will be sourced from the current
mode (tab) that you are in.
Save the current report to file – Once you get the look and feel of your report, you can then export the report to
one of the many popular document formats supported such as Microsoft Excel sheets, Word documents, Adobe
PDF, Rich Text or web page etc. for sharing with others users, or for future reference.
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List report view mode – This acts like a template to the other three report modes. For finer control over the
output of report, you can choose which fields (including custom fields) are to be included in the report. You can
sort the timesheets by clicking at the column headers, as well as also re-arrange the columns in the list view
according to certain sequence of your choice, and even set the width of the columns. These formatting from the
List view panel will be inherited on other tabs - HTML, editable HTML and Grids.

HTML report view mode – This report view presents the timesheets in web HTML format with color coding, group,
and summary information retained. You can export this report to .htm format for your further use.
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HTML Editable report view mode – This report view is exactly the same as the previous HTML mode, but with the
flexibility to edit the HTML content in a WYSIWYG editor. For instance, you can customize the font, add image,
change the color, layout or add any further information you require so that you can compile your own report.
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The Grid report view mode – This presents the timesheets in excel spreadsheet like format with rows and
columns, preserving color codes, summarized information etc. You can also re-edit and tweak the report. You can
also copy data from this grid to Microsoft Excel or vice versa. And you can of course export the report as Excel
spreadsheet file (in XLXS, XLS format).

8. TimeSheet Audit Manager
Team TimeSheet Manager > Audit Manager
With this auditing tool, supervisors and managers can review submitted timesheets and other project deliverables and make
amendment to project, activity or cost and can approve or decline the reported timesheet. The interface and control sets
remained the same with the new search/report tool (described in previous sections). The only additional features in Audit
Manager tool being able to edit, delete, approve or decline timesheets published by your users.
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Detail Info - Click this to view finer detail information of the selected timesheet (as available in the project
database) in a new window.

Edit - Click this to edit the published timesheet. Depending on the permissions as set by the administrator under Team
TimeSheet Manager > Audit Options panel, you can edit or make amendment to the published timesheets stored in
the project database directly.

Print – Click this to print the selected timesheets using the 'Print' template (as defined under Team TimeSheet
Manager > Templates Manager). if you select a single timesheet to print, it will show you the print dialog
option, where you can customize the layout, paper size etc. However, if you choose multiple timesheets, it will
print directly using the default settings without displaying any Print options.
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Delete – Click this to permanently remove the selected timesheets from the project database.

Approve – Click this to approve the published timesheets from users. Approved timesheets appear with a green
back color for easy recognition. Based on the choice, the add-in may send an alert to the owner (user) of the
timesheet informing about the approval.
This notification can be enabled from the ‘Audit Options’ settings.

Decline - Click this to decline the published timesheets from users. Based on the choice, the add-in may send an
alert to the owner (user) of the timesheet informing about the decline.
This notification can be enabled from the ‘Audit Options’ settings.

Declined timesheet can also be removed permanently from the database, if it is enabled from the ‘Audit
Options’.

Export to PDF - Click this to export the selected timesheets to PDF document files. You can also export to Word
Documents, HTML, plain text etc.
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You can control what timesheet data are included in the exported files by customizing the 'Print' template under
Team TimeSheet Manager > Templates Manager.

9. TimeSheet OLAP Statistics and Reporting
Team TimeSheet Manager > TimeSheet OLAP Statistics
With the integrated Online Line Analytical Processing (OLAP) tool, managers can analyze submitted timesheets and other
project deliverables in multidimensional view to extract critical information and intelligence that will enable them to take
better decisions in business. The tool will allow you to explore large complex data sets and allows displaying in grids, charts
and graphs and support most common operations such as pivoting, drill down/slice and dice, filtering etc.
Advantage of OLAP
Real strength of OLAP is its ability to examine and view data in ways not ordinarily possible. By allowing varying levels of
granularity during data inspection and visualization a lot of information can be revealed that would otherwise be hard to
attain. Given that most business models are constrained by more than three dimensions, it is hard to fully evaluate a business
without the ability to inspect each dimension in detail while preserving context eliminating all guesswork. OLAP is perfectly
suited for this purpose. Now it’s easier than ever to spot new trends and discover unknown problems in your data flow. The
statistical tool will help you gain an insight into your data and make new discoveries. It comes with various inbuilt reports
specific to Team TimeSheet.
Reporting made easier - The statistical tool's simplistic point-and-click interface will ensure managers easily achieve the highlevel views of information they require. Additionally, the OLAP client makes creating reports destined for different
management levels a simple task - eliminating managers' dependence on IT personnel. By unifying data analysis needs on a
single platform, it provides an unparalleled array of reporting tools for web portals, intranet applications, websites, and other
data-rich applications.
Printing capabilities - You can print your report to share it with others using the built-in Print Preview window. You can tune
your page/printer settings before printing. Also, if you want to share the report through the net or by email you can easily
export it to a wide range of formats including PDF, XLS, CSV, JPG, etc.
Copy to Clipboard - Select any data range in Chart/Grid and copy to clipboard. Then you’ll be able to paste it in an Office
program for further analysis. You can also paste the chart like a picture to illustrate your investigations. This greatly simplifies
the task of creating detailed, data-rich documents.
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Save Reports in file - At any stage managers and members can save the report and distribute it to another person for analysis
by network or email, so when the recipient gets the file he can open it and see the same OLAP slice.

9.1 The User Interface

This statistical tool presents an easy-to-use interface for operating an OLAP-slice. The basic data is displayed in the working
area. The environment tools for managing the content and characteristics of the slice are placed on the pivot panels. You can
set the panels' layout the way you like. To drag a panel to a different location, you need to capture and drag its header with
the mouse. This will highlight all the possible locations where it can be dropped. You can detach a panel from the component;
it will be displayed as a float window. Instrumental panels can be:
• Attached to any side of the component;
• Placed into any existing panel;
• Displayed as bookmarks on any panel;
• Set as auto-hidden panels;
• Used as float windows.

Page

52

The File menu
The file menu consists of the following commands:

a)

Open Offline Cube from file - While generating a live cube from the timesheets database provides the
advantage of analyzing live data, often, you might be away or disconnected from the network.
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In such scenario, you have the option of connecting to an offline cube, which was previously generated and
saved to your local folder using this utility. An offline cube file has the extension – ‘.offlinecube’ and can be
either in compressed or uncompressed format. An offline cube gives the same functionality as that of a live
cube (which is generated from the database at real time), except that the data in the offline cube is only
current to the time the cube was saved to file. This provides the flexibility to continue analyzing the cube
and writing reports etc, while you are on the move.
b)

Open a Predefined View - More than 30 views specifically designed for Team TimeSheet are included.
Simply select a view and click ‘Load’ or double-click to load the statistical analysis of that report, the result
will be displayed in the Grid or Chart (depending on the current active view).

c)

Open report view from file - Once a particular snapshot of the statistics is achieved, you may want to save it
for future reference or share it among your team members. A report view is the current state of the
statistics in the Grid/Chart working area, with specific member fields on the pivot panels (Rows and Column
areas) and measure fields in the values area. It has a file extension ‘.olapreport’.

d)

Save report view as - If you want to share a report view with others, you can simply save the current report
(state of the statistics along with the pivot details) to a file folder of your choice - could be a network folder
also.

e)

Save to offline Cube – Once you have loaded a live cube from the timesheets database, you have the option
to save the entire cube data to a file (with the extension .offlinecube) for offline use, when you are
disconnected from the network. Offline cube can be saved in compressed or uncompressed format, the
former option will enable you to reduce the file size considerably.

f)

Same as e. (above)

g)

Close the cube - This option closes the cube from the OLAP Statistics and free up the memory for loading
another cube.
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View Menu
Contains actions that you can perform on the current report view.

a) Reset Chart/Grid - Empty all the member fields from the pivot as well as the data from the working area of the
chart/grid. This is useful if you want to start over on a new report view.
b) Synchronize Chart/Grid - This option allows you to reflect the state of the statistics between Grid and chart. It is
particularly useful, for example, when you have build up a grid with aggregated data, but with a more visual
representation of the statistics in the form of graphs and bars. Also note that, the synchronization will be done
to the other part (grid or chart) based on the current interface.
For example, if you are in the grid view, and if you press ‘Synchronize Chart/Grid’ it would read the state of the
Grid view and impart the same state (same members and measures) to the Chart view and vice versa. Each of
the Grid and Chart views can be worked independently as long as you don’t press this synchronize option.
OLAP Grid panel
The OLAP Grid control comprises of a multi-dimensional table with expandable nodes. These nodes group and
display data according to the hierarchies used to define the measures and dimensions upon which the underlying
data has been organized. A unique feature of control allows for building the OLAP-reports of the exceptional level
of complexity. In tandem with the OLAP Chart, the OLAP Grid provides an ideal means of clearly conveying data
to the user.
OLAP Chart panel
While OLAP Grid allows working with numbers, the OLAP Chart allows representing the project data graphically.
This gives managers and members a unique opportunity to analyze their project data visually, dealing with charts
rather than numbers, which is much easier to perceive.
Cube structure panel
The panel contains the Cube structure - measures and hierarchies as a tree. The measures are grouped in the set,
displayed in a branch. Rest of the tree nodes are the dimensions that contain hierarchies.
- Measure
- Dimension
- Attribute hierarchy
- Multilevel hierarchy

To select a measure for display you need to drag-n-drop it to
the Measures panel or the data area.
To select a hierarchy for display – drag-n-drop it to the
hierarchy area or the pivot panel (rows or columns area).
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•
•

Measures are grouped in the Measures category.
Hierarchies are sorted into folders - dimensions. If there's
only one dimension in a hierarchy, it will be displayed in the
tree root.

Both hierarchies and measures have their own menus. Right click will call the context menu that gives you an
option to place the element where you like. You can also filter the selected element (see Filtering hierarchies and
measures) or place it to the selected panel.
Pivoting panels
A pivot table lets user design the report online by dragging and dropping measures, dimensions and levels into
the pivoting panels. Note that the column panel may contain no more than one (!) measure. Panel elements can

be dragged with the mouse to other panels. To filter elements, press the Filter button (see Pivot panel view) or
use the appropriate items from the context menu.

Measure panel
Measure panel consists of groups of measures that make up the charts' vertical axes (see Measure panel
components). Each group of measures corresponds to a set of charts in the data area. Groups of measures are
situated in the main part of the panel.
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You can drag measures from one group to another, or extract measures from groups to delete them. To create a
new group, you need to drag a measure to a place on the panel not occupied by another group or to the <drop an
item to create a new group> panel.
Clicking a mouse button on measures will call the context menu. From here, you can move a measure to one of
the pivot panels or to the modifiers axis, or assign a measure filter. Also, you can assign the marker type of a
chart point and its color.

Filter panel
This statistical tool allows for easy selection on what data you want to see and what you don’t. You can apply
powerful filters to anything including hierarchy members, and measure values, thus leaving out the unimportant
data. You can sort the data to see, for example, the top 10 values and then you can gather the rest of the values
into a single group, so you only have what you really need.

The filtered elements (hierarchies and measures)
are automatically transferred to the Filter panel.
To assign a filter, you have to move an element
to the Filter panel. If the element hasn't been
filtered the appropriate visual filter editor will be
shown, similar to the one on the right:

In the Filter panel, you can call the Filtered Element Editor individually for each element.

Working Area
The OLAP-slice data is displayed in working area. In its upper part there is a menu for the quick access to the
frequently used commands². The rest is occupied by the current OLAP-slice and consists of the following parts Cube Axis headers, Cube Axes, Data Axes, Data Axis headers, Chart Panes.
You can change the view of the slice by relocating measures and hierarchies within the environment panel. When
you start dragging an element, all the possible locations, where it can be dropped to, will be highlighted. Most
elements have context menus that duplicate the mouse actions and provide additional control functions for
managing the slices' view.

Page

57

Grid working area
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Chart working area

9.2 Working with the OLAP grid
The OLAP Grid view comprises of a multi-dimensional table with expandable nodes. These nodes group and display data
according to the hierarchies used to define the measures and dimensions upon which the underlying data has been organized.
In tandem with the OLAP Chart view, the OLAP Grid view provides an ideal means of clearly conveying data to the user. It is
highly navigable and quickly provides detailed information to the user. The speed with which data recall occurs and the strong
formatting the grid enforces ensure data is always presentable and easily understandable. Consequently, OLAP Grid views can
easily be ported to spreadsheet applications for report compilation purposes.
Additionally, the OLAP Grid view allows users to effortlessly add and remove categories, filter and sort categories, and drill up
or drill down on data using powerful built-in menus. One of its greatest benefits is that it allows users to explore, navigate and
refine data until the desired snapshot is achieved. Once in place this snapshot can be reflected in a complementary chart. This
is possible as OLAP operations in Grid view can be synchronized with Chart view. These two data views can then be deployed
side-by-side or on top of one another.
Unicode support.
Simultaneous display of several different measures in the Grid.
Simultaneous drilling down based on different parameters: up to the nearest child, up to the next level, up to the next
hierarchy.
Saving and restoring the current OLAP-slice.
Hierarchy members grouping (including multilevel and parent-child hierarchies).
Separate sorting on different hierarchy levels. Possibility to override any sorting method.
Ascending or descending sorting based on the cell values in any column of the Grid.
Filtering of hierarchy members with or without applying these filters to the OLAP calculations.
Auto filtering of the hierarchy members depending on their values in the Grid. Major/minor members selection, either
based on their rank or on the Pareto principle.
Replacing hierarchy members by drag-n-dropping them within the Grid.
Auto sizing of cells depending on their contents.
Flexible export to MS Excel, HTML, GIF, JPG, PNG, BMP, CSV, TXT, PDF formats.
Operating the OLAP-slice
The OLAP-slice data are displayed in a table, whose appearance may be amended to some extent. For operating the current
OLAP-slice there are the following functions available:
1.
2.
3.
4.
5.
6.
7.

Navigation
Selecting and copying data
Drilling, sorting and moving hierarchy members
Operating context menus
Filtering data
Editing data
Setting the column width

1. Navigation - You can easily navigate the data using the keyboard:
Button
Home
End
PageUp
PageDown
Ctrl+Home
Ctlr+End

Action
Move to the first cell of the row
Move to the last cell of the row
Move one page up
Move one page down
Move to the top left cell
Move to the bottom right cell
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Using the mouse, you can scroll the table up and down.
Mouse Action
Scrolling the mouse wheel

Component Action
Vertical scrolling of the table

Scrolling the mouse wheel with the Shift button held
down

Horizontal scrolling of the table

2. Selecting and copying data - The data area in the component can be selected like everything else in Windows:
•
•
•

Select all the cells pressing Ctrl+A;
Capture the area with the mouse;
Change the boundaries of the selected area with direction buttons, holding down the Shift button.

You can copy the data from the selected area to the clipboard by pressing Ctrl+C. If there’s no selection, pressing these buttons will
copy the whole OLAP-slice to the clipboard.
3. Drilling, sorting and moving hierarchy members - To
perform the drilling of the hierarchy members press
buttons on the Grid cells. If there’s only one drilling
button in a cell, then, instead of pressing it, you can
double-click the cell itself. By default, the drilling
buttons are shown only in the cells under mouse. To see
all the buttons, press the Ctrl button. The last cells in
the column area of the hierarchy members allow
showing the sorting direction. A pointer that indicates
the descending order of data illustrates it. You can
manage the sorting modes by single clicking on the cells
of the specified area: they are changed cyclically
[descending sorting] -> [ascending sorting] -> [no
sorting].
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4. Operating context menus -The context menu,
called by right clicking a table cell, partly duplicates
the OLAP-slice control functions.

Hierarchy levels' menu
The view of context menu of the hierarchy levels' area. There is a list of commands available in the context menu of the hierarchy
levels’ area:
Command
Show totals first
Show totals last
Don’t show totals
Default sorting
Sort ascending
Sort descending
Aggregate all hierarchy
members
Aggregate visible members only
Drill all down\ to the next
hierarchy
Drill all down\ to the next level
Drill all down\ to the same-level
children
Drill all up
Clear filter
Filter on captions
Show empty cells
Create new group …
Copy selection
Conditional formatting

Function
Show the aggregated cells before all the rest
Show the aggregated cells after all the rest
Do not show the aggregated cells
Range hierarchy members by default
Range the hierarchy members by values from the bottom to the
top
Range the hierarchy members by values from the top to the
bottom
Aggregate all the hierarchy members (including hidden)
Aggregate the visible hierarchy members only
Drill all down to the next hierarchy
Drill all down to the next level
Drill all down to the same-level children
Collapse all the elements of this level
Remove any applied filters
Set the filter for measures
Show the cells with no aggregated values
Create a new group. It will appear at the first level of the
hierarchy
Copy the selected area to clipboard
Show the Conditional formatting menu

Hierarchy members' menu
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The view of the context menu of the hierarchy members' area
Command

Function

Drill down to the next
hierarchy
Hide this member
Hide all members except
this
Hide all members above
this
Hide all members below
this
Show only the top

Show only the bottom

Filter on captions
Create new group..
Copy selection
Conditional formatting

Open the node up to the next hierarchy in the current area, ignoring
all the lower levels of the current hierarchy
Hide the member
Hide all the members of the hierarchy, except the selected one
Hide all the members of the hierarchy above the selected one
Hide all the members of the hierarchy below the selected one
Show the top elements of the level. Their number is specified in the
sub-menu. If you specify a percent value there, then the picking of
members will be such that their total value does not exceed the one,
specified in the sub-menu.
You can choose a threshold value from those offered in the
appropriate menu item or set your own one, selecting Other from the
menu.
Show the bottom elements of the level. Their number is specified in
the sub-menu. If you specify a percent value there, then the picking of
members will be such that their total value does not exceed the one,
specified in the sub-menu.
You can choose a threshold value from those offered in the
appropriate menu item or set your own one, selecting Other from the
menu.
Set the filter for measures
Create a new group on the current level
Copy the selected area to clipboard
Show the Conditional formatting menu

The menu for groups of hierarchy members
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The context menu that appears above the group cell.

Command
Hide this member
Hide all members except this
Hide all members above this
Hide all members below this
Show only the top

Show only the bottom

Filter on captions
Create new group
Delete this group
Clear this group
Rename this group
Copy selection
Conditional formatting

Function
Hide the selected member
Hide all the hierarchy members except the selected one
Hide all the hierarchy members above the selected one
Hide all the hierarchy members below the selected one
Show the top elements of the level. Their number is specified
in the sub-menu. If you specify a percent value there, then the
picking of members will be such that their total value does not
exceed the one, specified in the sub-menu.
You can choose a threshold value from those offered in the
appropriate menu item or set your own one, selecting Other
from the menu.
Show the bottom elements of the level. Their number is
specified in the sub-menu. If you specify a percent value there,
then the picking of members will be such that their total value
does not exceed the one, specified in the sub-menu.
You can choose a threshold value from those offered in the
appropriate menu item or set your own one, selecting Other
from the menu.
Set the filter for measures
Create a new group
Delete the selected group
Clear the selected group
Rename the selected group
Copy the selected area to clipboard
Show conditional formatting menu
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Measure values' menu

The context menu that appears above the group cell:
Command
Function
Sort ascending
Range the cells in the column by values from the
bottom to the top
Sort descending
Range the cells in the column by values from the top
to the bottom
No sorting
Remove any sorting
Filter on captions
Set the filter for measures
Hide this measures
Hide the selected measure
Show as
Specify the display mode of the current measure in
the Grid:

Copy selection
Conditional formatting

default
percent aggregated value in the row
percent parent element of the row
percent parent element of the column
percent total aggregated value
Copy the selected area to clipboard
Show conditional formatting menu

5. Filtering data - The filtered elements (hierarchies or measures) are automatically placed on the filters' panel. To start filtering,
move the element to the filters' panel. In case the element has not been filtered, the appropriate editor will launch (the Hierarchy
Editor for hierarchies and the Measure Filter Editor for measures). In the filters' panel, you can launch an editor for each element
independently.
The buttons for launching the editor ( ) are placed on the
panels in the Hierarchy levels’ area. If the button looks like
this ( ), it means the hierarchy had hidden members inside.
Pressing the button starts the Hierarchy editor.
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6. Setting the columns' width - You can change the width of columns in the data display area by dragging the right boundary with
the mouse. If possible, these changes will be saved during other operations with the table (like drilling, sorting, etc.) To return to the
original width, double click the right boundary of the column where it is visible. In case there were such changes in the table that
saving the assigned width of the columns was impossible (for example, if as a result of the Collapse drilling, the column with the
assigned width has disappeared), it will be set automatically. Unfortunately, if you operate a big table, calculating the columns’
width takes up too much time. That is why if there are more than 10, 000 cells in your table, their width will be set to default, but it
can be corrected later.

9.3 Working with OLAP Chart
While the Grid view allows working with numbers, chart view allows representing submitted project data graphically. This
gives you and other managers a unique opportunity to analyze reported data visually, as dealing with charts rather than
numbers, is much easier. Now it’s easier than ever to spot new trends and discover unknown problems in your data flow. The
statistical tool will help you gain an insight into your data and make new discoveries.

Tools panel
This panel houses all the frequently used operations on the OLAP chart - save, export, print and display options.
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Button

Function
Load the Grid state
Save the Grid state
Export OLAP-slice data
Print OLAP-slice data
Preview
Undo
Redo
Switch axes
Select the docking panels layout
Set the scale of Chart display
Select the color palette for measures

Modifier panel
Modificators are easy and powerful means of data representation. You can choose your data be shown in different colors, using
different shapes and sizes, so that you can easy distinguish them in a single graph. You can simply place a dimension or a measure on
a modificator’s pane and get the graph showing different values in a different manner.
For example, you might place the "Problem Category" dimension on Color pane and get the Chart showing problem categories in
different colors. Or you can place the "Cost" measure on Color pane to highlight the top rates of supporting the service requests. The
same can be done for Shape and Size so that you can make your data perfectly distinguished.
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The layout of panels and hierarchies on the Modifier panel allows you to change the appearance of the displayed slice. When an
element is placed to the modifier panel (except for Details), its legend will contain the display parameters. If you modify the color
and shape of an element, the appropriate parameters can be amended.
Modifier

The changes made upon placing a Chart element to the modifier area of...
a measure
a hierarchy
The color of the Chart elements will be
Hierarchy members will be painted with
chosen from the standard set of gradient
the colors from the current palette
colors

Color

The elements with the minimal value will
be painted with the first of the gradient
colors, and the elements with the
maximal value - with the last one

N/A

Size

Depending on the value of the measure
the size of the Chart points will vary
from the minimal to the maximal.

Hierarchy members will differ in size

Shape

Forbidden

Hierarchy members will differ in shape.
If the number of hierarchy members will
exceed the number of available shapes,
some of them will be used more than
once

Details

Forbidden

The panels will display series for all
hierarchy members

If a measure is placed on the Color pane, its values range is mapped to the given colors range so that it’s tremendously easy to spot
the top/low values. If you select the discrete gradient type, you'll be able to set threshold values for filling the Chart elements. While
the continuous gradient will let you evaluate the trend as a whole. To select the gradient type and tune its content, turn to the
legend panel.
The Legend panel
The panel contains descriptions of the modified elements.
The value, shape and color of a legend element can be
edited.
Setting the Color legend
To select a color, simply double-click the appropriate element
and choose a color from the pop-up editor.

Setting the Gradient legend
To edit the gradient, double-click the element and tune the settings in the
editor. In the Gradient Editor there are:
•
•
•
•

a set of pre-made gradients;
selecting gradient option (continuous or discrete);
creating a gradient with a set number of intermediate colors option;
setting threshold in per cent and measure values option;
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Selecting threshold color option.

Setting the Shape legend
The shape selection is made through the context menu. This
option is available only for points or lines Charts. If the
number of hierarchy members exceeds the number of
available shapes, they will be repeated.

Chart Panes
The bulk of the OLAP-slice data are placed into cells with Charts. Each measure group has its own set of panes.
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Measure groups with corresponding Charts in the working area

Chart Type
In the upper left part of each Chart, there will appear a
context menu for selecting its type. There are six (6) charts
that you can use, namely, Point Chart, Histogram, Point
Shape Selection, Lines, Curved lines and Step lines. By default,
the Histogram is used.
The size of Charts can be changed to some extent. To expand
a Chart along either one of the axes, you need to capture its
boundary with the mouse and drag it. You can change the
size along both axes (and return to default) through the tool
menu in the upper part of the working area.
Chart type menu

Hot keys for changing the scale
Ctrl+*
Reset Scale to 1:1
Ctrl+Num+
Zoom In
Ctrl+NumZoom Out
Navigation
If the content of the Grid exceeds the client area, the scroll bars will appear. You can scroll down the data using the mouse wheel. To
scroll the Grid in the vertical direction, turn the mouse wheel, while holding Shift.
Selecting Data
You can select Chart points with the standard Windows' method. Holding down the Ctrl button, you can add selected points,
holding down the Shift button, you can select the horizontal range. You can filter the Grid's points while selecting. In that
case, the corresponding hierarchy members will be filtered automatically.
Selecting and filtering parts of Charts
a. Selecting some of the Chart points
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b. Selecting the Filter command

c. The result

Note: When moving the mouse cursor over a data axis, you are able to select a continuous range of members (if the axis is
composed of them) or a range of values in Charts.

Filtering hierarchies
In case you need to collect data not from the whole Grid, but just from a part of it, the component has a few functions at your
disposal: they let you select or remove elements from the slice. Also, there is a standard option of exporting data into a
number of formats and printing out the content of OLAP-slices. The simplest way of selecting data is through the context
menu. When you click a hierarchy member on the Cube axis, there is a set of commands for quick operations with members:
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•
•
•
•

Hide this member
Hide all members except this
Hide all members above this
Hide all members below this

Filter on hierarchy level
The Filter area of the Editor becomes visible only in case if filtering by hierarchy levels is available. To apply a filter to hierarchy
members, you need to select a hierarchy level (if there's more than one) and assign the Filter condition in the Filter menu. In the
same menu, there's a command to clear filter.
Filtering hierarchy members

If the search field is not empty, the "Find" command will make the component perform a search for hierarchy members, whose
levels contain the specified string. You can narrow the search results by checking the "Exact matching" box.
Filtering a single member of a hierarchy
By default, the Editor is able to select any number of hierarchy members. To switch to the single-select mode, uncheck the
"Multiselect" box. In that case, only one the hierarchy member with all its parents and members will be selected.
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Filtering measures
There is a number of available parameters for filtering measures. In the same Editor, you can clear the filter.

9.4 Printing, exporting statistical data and charts
Now that you have successfully designed a report, you might want to save it for future reference or share it with others.
Reuse your work! You can now save data snapshots to HTML, BMP, CSV, GIF, HTML, JPEG, PDF, PNG, TIFF, TXT, XLS and XML
as a simple way of reusing your data for documents and spreadsheets. Depending on the active view (Grid or Chat), the saved
file would either take the grid data or the chart.

Available export formats in Chart View

Available export formats in Grid View

Page

72

Printing
You can print your report to share it with others using the built-in Print Preview window. You can tune your page/printer settings
before printing. Also, if you feel like sharing the report through the net or by email you can easy export it to a wide range of formats
including PDF, XLS, CSV, JPG, etc.
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Export Settings -This tool allows you to customize the appearance of the reports to be printed or saved to a file format. You can
specify the page size, orientation, headers & footers and color of the fonts and page background.

10. Uninstalling Team TimeSheet Manager add-in
To uninstall the Team TimeSheet Manager Tool from your computer, follow the steps outlined below:
Step 1: Go to ‘Control Panel > Programs and Features’. Scroll down to select ‘Team TimeSheet Manager (x86) or (x64)’ and
click ‘Uninstall’ as illustrated below:

Step 2: A dialog confirmation follows asking for confirmation. Click Yes.
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Step 3: The Team TimeSheet setup will now start the un-installation process. Make sure that Microsoft Outlook is not running (even
under the task manager).

11. Important links
Team TimeSheet for Outlook- HomePage
Go to the official website of Team TimeSheet for Outlook.
Video Tutorial clips
Watch video tutorials that teach you how to install, configure and work with Team TimeSheet.
Purchase license
Purchase an enterprise team license for Team TimeSheet for Outlook.
Knowledgebase articles
Looking for an in-depth understanding of this application? Browse through a series of knowledge base articles
on Team TimeSheet online.
Support Maintenance contract
At AssistMyTeam, we're committed to give you the best support for all the products that we offer and more!
The AssistMyteam Support Contract helps you use our products more efficiently and work out any issues that
you encounter during the course of their use.
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Submit an online support ticket
Use this web form to create a ticket with AssistMyTeam Technical Support.

